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CHAPTER

ONE

PRE POUŽÍVATEL’OV

1.1 Inštalačný návod (VC12)

v1.6 (13. 03. 2016)

1.1.1 Changelog

v1.6 - 13.03.2016

• návod pre MS VisualStudio 2013

• aktualizovaný Qt (5.5.1)

v1.5 – 17.11.2015

• aktualizované Aruco využíva FreeGlut

• upravené nastavenie pre build v QtCreator

v1.4 - 27.10.2015

• aktualizovaná knižnica OSG (v3.4) – nahradené zdroje

• zmazaný import chýbajúcich knižníc

v1.3 - 11.10.2015

• pridaný krok vytvorenia build konfigurácie

v1.2 - 06.10.2015

• pridaný postup pre buildovanie OSG knižníc

• pripojený zdroj s uploadnutými OSG knižnicami

• zvýraznené dôležité poznámky

v1.1 - 28.09.2015

• doplnené obrázky

• aktualizované zdroje

• vyriešené chyby

• zmenené poradia krokov
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1.1.2 Časté problémy

Inštalácia softvéru 3DSoftViz pozostáva z mnohých krokov. Pozorné postupovanie podl’a inštrukcií je nevyhnutné,
inak sa môžu vyskytnút’ problémy. Nasledujúce problémy sme identifikovali.

Ponuka generátorov je prázdna

Ak sa generátor nedá vybrat’, je dôležité zmazat’ súbor CMakeLists.txt.user.2.5pre1 z %3DSoftViz% a zopakovat’
predošlý krok.

CMake - chýbajúce moduly

1. cez git shell prejst’ do %3DSoftViz%

2. uistit’ sa, že je nastavený na master vetvu

• na prepnutie: git checkout master

3. zadat’ príkaz: git submodule update –init

CMake - cesta nebola nájdená

Ak nebola nájdené cesta k niektorému modulu, treba skontrolovat’ nastavenia premenných v RapidEE.

Chyba spojená s glut.h, glut.lib, glut.dll

Pokial’ sa vyskytnú problémy typu:

• nevie nájst’ glut.h

• hlási chyby priamo v glut.h

• niečo iné s glut.h, glut.lib alebo glut.dll

Tak najjednoduchšie riešenie je premenovat’:

- %OSG_DIR%/ThirdParty/VC10/x86/include/GL/glut.h > ../glut.h.bak
- %OSG_DIR%/ThirdParty/VC10/x86/lib/glut32.lib > ../glut32.lib.bak
- %OSG_DIR%/ThirdParty/VC10/x86/lib/glut32D.lib > ../glut32D.lib.bak

Pri spustení crash programu s nullpoint exception

Pokial’ sa projekt spustí iba cez argument: -DCMAKE_BUILD_TYPE=Release, ale cez -
DCMAKE_BUILD_TYPE=Debug hlási nullpoint exception pri načítavaní obrázkov na pozadie a program
crashne. Tak riešením je znovu stiahnut’/nakonfigurovat’ OSG podl’a návodu.

Zm### pri buildovaní

Ak došlo k erroru pri buildovaní: -Zm###, treba vykonat’ úpravu v CMakeLists.txt > riadok 128 zmenit’ /Zm216 na
/Zm240 a spustit’ CMake odznovu.

4 Chapter 1. Pre používatel’ov
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1.1.3 Návod pre Windows

Tento návod bol úspešne otestovaný na operačných systémoch Windows 7, 8, 8.1, 10.

Potrebný softvér

Uvedené programy neinštalovat’ do Program Files, PATH nesmie obsahovat’ medzeru! Na inštaláciu potrebu-
jeme klonovat’ projekt 3DSoftViz (Tím č.4 klonuje z /cimox/3dsoftviz) z Githubu a stiahnut’ nasledovné:

• CMake (v3.6.2)

• OpenSceneGraph (jeden z nasledujúcich)

– OpenSceneGraph (source) - iba zdrojové súbory -> treba buildnút’ (cca 40-60min)

– stable release: OpenSceneGraph (v3.4.0) - buildnuté (13.03.2016)

– developer release: OpenSceneGraph (v3.5.1) - buildnuté (13.03.2016)

• Kinect for Windows SDK 1.8

• Microsoft VisualStudio 2013 (okrem Express edition!)

• Qt (v4.8.6)

• QtCreator (v3.6.1)

• OpenCV (v2.4.10)

• Boost (v1.57.0)

• RapidEE - program na prácu s premennými prostredia

• Inštalácia knižnice 3rd party dependencies VC12

• OpenNI2

• NiTE2

• Debugging Tools for Windows

– WinDbg - Win 8.1

– WinDbg - Win 10

Postup inštalácie

Uvedené programy neinštalovat’ do Program Files, PATH nesmie obsahovat’ medzeru! Idealne vsetky programy, kniznice, atd. dat do jedneho adresara.

1. Nainštalovat’ CMake. (Cesta je v dokumente označená ako %CMAKE_DIR%). Pri inštalácií zvolit’ “Add
CMake to the system for all users”.

2. Nainštalovat’ Qt (%QT_DIR%)

3. Nainštalovat’ QtCreator.

4. Vytvorit’ zložku OpenSceneGraph (%OSG_DIR%)

5. V prípade stiahnutia zbuildovaných súborov OSG (mega.nz)

(a) Rozbalit’ zložky build a install do %OSG_DIR%

(b) Vynechat’ nasledujúci krok.

1.1. Inštalačný návod (VC12) 5
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6. V prípade stiahnutia iba zdrojových súborov OSG (oficiálna stránka)

(a) Rozbalit’ OSG do %OSG_DIR%/source

(b) Vytvorit’ zložku build a install v %OSG_DIR%

(c) Rozbalit’ 3rd Party Knižnice (VC12) do %OSG_DIR%/ThirdParty/

(d) Spustit’ CMake (cmake-gui.exe)

i. source code > %OSG_DIR%/source

ii. binaries > %OSG_DIR%/build

iii. stlačit’ Configure (VS2013 kompilátor)

iv. nastavit’ 3rdParty na %OSG_DIR%/ThirdParty/VC12/X86

v. stlačit’ Generate

• ak došlo k erroru: File > Delete Cache a skúsit’ znovu

Fig. 1.1: CMake pre OSG

6 Chapter 1. Pre používatel’ov
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(e) Nájst’ súbor OpenSceneGraph.sln v %OSG_DIR%/build

(f) Otvorit’ súbor vo VS2013 (ako správca!)

(g) Nastavit’ Solution Configuration na Debug

(h) Nájst’ projekt ALL_BUILD > pravý klik > build

(i) Po skončení nájst’ projekt INSTALL > pravý klik > build

(j) Nastavit’ Solution Configuration na Release

(k) Nájst’ projekt ALL_BUILD > pravý klik > build

(l) Po skončení nájst’ projekt INSTALL > pravý klik > build

(m) Presunút’ nainštalované súbory (default c:Program Files (x86)OpenSceneGraph) do
%OSG_DIR%/install

7. Nainštalovat’ OpenCV (%OPENCV_DIR%)

8. Rozbalit’ Boost (%BOOST_DIR%)

Ideálne je mat’ všetko na spoločnom mieste kvôli prehl’adnosti, napr.

Fig. 1.2: Nainštalovaný SW

9. Otvorit subor environment.txt a upravit v nom cesty k programom a knizniciam, ktore sa nachadzaju na
zaciatku suboru.

Fig. 1.3: Pozadovane premenne, ktore treba nastavit

1.1. Inštalačný návod (VC12) 7
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(a) Spustit powershell ako spravca .

(b) Skopirovat do powershellu obsah celeho suboru.

(c) Vynechat pridavanie systemovych premennych cez RapidEE (nasledujuci krok) a vykonat
len kontrolu, ci sa cesty spravne nastavili.

10. Nainštalovat’ a otvorit’ RapidEE, v ktorom sa vykonajú tieto zmeny (ako správca!):

(a) do PATH pridat’ premenné:

i. %CMAKE_DIR%/bin

ii. %QT_DIR%/bin

iii. %QT_DIR%/Qtcreator/bin

iv. %OSG_DIR%/build/bin

v. %OSG_DIR%/ThirdParty/VC12/x86/bin

vi. %OPENCV_DIR%/build/x86/vc12/bin

Fig. 1.4: PATH premenná

(b) Vytvorit’ premennú CMAKE_INCLUDE_PATH a pridat’:

i. %OSG_DIR%/install/include

ii. %OSG_DIR%/ThirdParty/VC12/x86/include

iii. %OPENCV_DIR%/build/include

Fig. 1.5: CMAKE_INCLUDE_PATH premenná

(c) Vytvorit’ premennú CMAKE_LIBRARY_PATH a pridat’:

i. %OSG_DIR%/build/lib

ii. %OSG_DIR%/install/lib

iii. %OSG_DIR%/ThirdParty/VC12/x86/lib

iv. %OPENCV_DIR%/build/x86/vc12/lib

(d) Vytvorit’ premennú BOOST_INCLUDEDIR a pridat’: %BOOST_DIR%/boost

8 Chapter 1. Pre používatel’ov
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Fig. 1.6: CMAKE_LIBRARY_PATH premenná

(e) Vytvorit’ premennú BOOST_LIBRARYDIR a pridat’: %BOOST_DIR%/libs

(f) Vytvorit’ premennú BOOST_ROOT a pridat’: %BOOST_DIR%

Fig. 1.7: BOOST premmené

(g) Vytvorit’ premennú OPENCV_DIR a pridat’: %OPENCV_DIR%/build

Fig. 1.8: OPENCV_DIR premenná

11. Nainštalovat’ Debugging Tools for Windows.

12. Naklónovat’ projekt 3DSoftViz cez git shell (%3DSoftViz%)

1. Naklonovat’ projekt 3DSoftViz cez git shell (%3DSoftViz%)

2. Cez command line prejst’ do naklonovaného projektu a zavolat’ git submodule –init –recursive

3. Vytvorit’ v priečinku %3DSoftViz% priečinky _build a _install

4. Spustit’ QtCreator. Tools > Options... > Build and Run:

(a) záložka CMake – zadat’ cestu %CMAKE_DIR%/bin/cmake.exe

(b) záložka Compilers – ak existuje VS2013 tak sú autodetected

(c) záložka Qt Versions – zadat’ cestu %QT_DIR%/bin/qmake.exe

(d) záložka Kits – vytvorit’ nový a vybrat’ hodnoty nasledovne:

(e) záložka General – nastavit’ default build directory: %3DSoftViz%/_build

(f) Potvrdit’ – OK

5. File > Open File or Project... > vybrat’ CMakeLists.txt z %3DSoftViz%

1.1. Inštalačný návod (VC12) 9
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Fig. 1.9: QtC Kits nastavenia

6. Zadat’ do pol’a Arguments jeden z nasledujúcich prepínačov:

• -DCMAKE_BUILD_TYPE=Debug

• -DCMAKE_BUILD_TYPE=Release

7. Vybrat’ z nastavený generátor – NMake Generator (názov kitu)

(Chyba: Generátor nebol nájdený <riešenie>)

8. Stlačit’ Run CMake

(Chyba: Chýbajúce moduly <riešenie>)

(Chyba: Cesta nebola nájdená <riešenie>)

9. Ukončit’ – Finish

10. Vybrat’ Projects > Build & Run > Build, v časti Edit build configuration kliknút’ na Add > Clone
selected, nazvat’ napr. „unity“

11. Prejst’ na vytvorený build config. „unity“, v časti Build Steps otvorit’ Details a zaškrtnút’ pri build
step jom.exe možnost’ install_unity

12. Skontrolovat’ nastavenie build config – unity

13. Stačit’ Build (kladivko vl’avo dole - potreba spravit’ znova po každej následnej úprave systémových
premenných)

10 Chapter 1. Pre používatel’ov
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Fig. 1.10: QtC CMake wizard

1.1. Inštalačný návod (VC12) 11
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Fig. 1.11: QtC build project

Fig. 1.12: QtC build config

12 Chapter 1. Pre používatel’ov
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14. Po úspešnom zbuildovaní vybrat’ Projects > Build & Run > Run, v časti Run pridat’ Add > Custom
Executable a nastavit’:

(a) executable: %3DSoftViz%/_install/bin/3DSoftviz.exe

(b) working directory: %3DSoftViz%/_install/bin/

Fig. 1.13: QtC run project

15. Skontrolovat’ nastavenie run config – zadaná cesta

16. Spustit’ program pomocou zeleného tlačidla Run

V prípade, že aplikácia ihned’ po spustení crashne, napriek úspešnému buildu, jedná sa pravde-
podobne o problém s grafickou kartou. Na notebookoch, ktoré majú externú grafickú kartu NVidia,
je v tomto prípade treba cez NVidia Control Panel nastavit’ jej použitie pre 3DSoftViz.exe

1.1.4 Rozšírenie 3DSoftviz o Kinect

1. Nainštalovat’ Kinect for Windows

2. Skontrolovat’ v RapidEE či sa vytvorila premenná %KINECTSDK10_DIR%

1.1. Inštalačný návod (VC12) 13
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Fig. 1.14: QtC run config

Fig. 1.15: KINECTSDK10_DIR premenná

3. Nainštalovat’ OpenNI2 (OpenNI-Windows-x86-2.2.msi)

• x86! – inak sa môžu vyskytnút’ problémy s linkovaním

4. Skontrolovat’ v RapidEE či sa vytvorili premenné:

(a) %OPENNI2_INCLUDE%

(b) %OPENNI2_LIB%

(c) %OPENNI2_REDIST%

(d) %OPENNI2_ROOT%

Fig. 1.16: NITE2 premenné

5. Nainštalovat’ NiTE2 (NiTE-Windows-x86-2.2.msi)

• x86! – inak sa môžu vyskytnút’ problémy s linkovaním

6. Skontrolovat’ v RapidEE či sa vytvorili premenné:

(a) %NITE2_INCLUDE%

14 Chapter 1. Pre používatel’ov
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(b) %NITE2_LIB%

(c) %NITE2_REDIST%

(d) %NITE2_ROOT%

Fig. 1.17: OPENNI2 premenné

7. Pridat’ do premennej CMAKE_INCLUDE_PATH:

(a) %OPENNI2_INCLUDE%

(b) %NITE2_INCLUDE%

Fig. 1.18: OPENNI2 premenné

8. Pridat’ do premennej CMAKE_LIBRARY_PATH:

(a) %OPENNI2_ROOT%/Driver

(b) %OPENNI2_REDIST%

(c) %OPENNI2_REDIST%/OpenNI2/Drivers

(d) %OPENNI2_LIB%

(e) %NITE2_ROOT%/Samples/Bin/OpenNI2/Drivers

(f) %NITE2_LIB%

9. Pridat’ do premennej PATH:

(a) %OPENNI2_REDIST%/OpenNI2/Drivers

(b) %OPENNI2_REDIST%

(c) %NITE2_REDIST%

(d) %NITE2_ROOT%/Samples/Bin

10. Spustit’ CMake a skontrolovat’ vo výpise:

1.1. Inštalačný návod (VC12) 15
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Fig. 1.19: OPENNI2 premenné

Fig. 1.20: OPENNI2 premenné

16 Chapter 1. Pre používatel’ov
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(a) OpenNI2 FOUND

(b) NITE2 FOUND

(c) KINECTSDK FOUND

1.1.5 Nastavenie debuggera v QtCreator

1. Nainštalovat’ WinDbg

2. Skontrolovat’ v QtCreator Tools > Options > Build & Run > záložka Debuggers či sú autodetected

Fig. 1.21: QtC debugger nastavenia

3. Pridat’ do QtCreator Tools > Options > Build & Run > záložka Kits pre vytvorený profil položku Debugger
(x86)

4. Spustit’ CMake (-DCMAKE_BUILD_TYPE=Debug)

5. Zvolit’ možnost’ Debug (vl’avo dole medzi Run a Build)

1.1.6 Portable zip s projektom (Windows)

1. Pri builde projektu treba nastavit build install_unity a CMAKE_BUILD_TYPE = Release.

2. Nastavenie v Qt Creator 4.2 a vyssie

3. V starsich verziach treba kliknut na Run CMake a do pola argumentov zadat: -
DCMAKE_BUILD_TYPE=Release

1.1. Inštalačný návod (VC12) 17
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Fig. 1.22: Qt creator build

4. Build projektu.

5. Stiahnut _install.zip . V zipe su popridavane dll subory, ktore program potrebuje.

6. Rozbalit zip na disk.

7. Do rozbaleneho priecinku nakopirovat obsah z adresara “3dsoftviz/_install/” (po buildovani)

8. Spustit _install/bin/3DSoftviz.exe.

1.2 Návod pre Linux

1. Nainštalovat’ Synaptic Package Manager

18 Chapter 1. Pre používatel’ov
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2. Nainštalovat’ prostredníctvom Synaptic nasledujúce programy

• Git - git

• OpenSceneGraph - libopenscenegraph-dev

• Qt4 - libqt4-dev

• QtCreator - qtcreator

• Boost - libboost-all-dev

• Lua - liblua5.1-0-dev

• OpenCV - libopencv-dev

• FreeGlut3

– freeglut3

– freeglut3-dev

• CMake 3.5.0

– inštalovat’ zo source files, nie Synaptic

Note: Názvy knižníc sú ukázané pre Ubuntu

3. Klonovat’ cez Git projekt 3dsoftviz (AlphaReach klonuje z repozitára Cimox)

• git clone ** url repozitára **

• git submodule update –init –recursive

4. Zbuildovanie projektu

1.2. Návod pre Linux 19
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• Otvorit’ QtCreator

• File >> Open file or project >> Otvorit’ CmakeList.txt v zložke 3dsoftviz

• Vytvorit’ projekt

– Ak úspešne (dá sa kliknút’ na FINISH) >> Kliknút’ FINISH

– Ak neúspešne – Nájst’ chybu vo výpise

5. Nastavit’ build v QtCreator-i

Projects >> Build and Run >> Build Build Settings >> Add >> Clone Selected >> pomenovat’ “unity”
- automaticky prepne na unity build mode Build Steps >> Details >> zaškrtnút’ install_unity

Nastavenie počtu jadier na buildovanie projektu... Details >> Additional arguments “-jN”, kde N
reprezentuje počet VIRTUÁLNYCH jadier

6. Pridanie Kinectu do projectu

• Nainštalovat’ NiTE – pridat’ systémové premenné

• Nainštalovat’ OpenNI alebo cez sudo apt-get install – pridat’ systémové premenné

• Naištalovat’ Freenect2 - postupovat’ podl’a <https://github.com/OpenKinect/libfreenect2/blob/
master/README.md#linux‘_ -je potrebné aby fungoval aj OpenNI test

Note: Ak je potrebný prístup k knižniciam kvôli vývoju tak je potrebné nastavit’ premenné
FREENECT2_INCLUDE a FREENECT2_LIBRARY

Note: Pre použitie je nutný Kinect for XBOX

Attention: Na OSX, ak je found OpenNI2 a NiTE2, aplikacia crashne pri spustani s chybovou hlaskou:

• not found libNiTE2.dylib

• not found libOpenNI2.dylib

Treba tieto kniznice skopirovat z ich domovskych priecinkov (z lib alebo redist).

20 Chapter 1. Pre používatel’ov
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7. Inštalácia drivera pre 3dmyš

• Nainštalovat’ Motif3 pomocou Synaptic Package Manager

• Pre uistenie, že 3dmyš funguje, skúsit’ xapp aplikáciu z drivera

– Pre spustenie drivera (ktory musi bezat pre pouzivanie mysi) spustite prikaz

sudo /etc/3DxWare/daemon/3dxsrv -d usb

– Pre podrobnejsie instrukcie ohladne instalacie a pouzivania drivera otvorit navod prilozeny v suboroch
oficialneho drivera pre Linux “InstallationInstructions_Linux.txt“

1.3 Používatel’ská príručka pre 3D Softviz

Okno s aplikáciou je rozdelené na tri základné časti:

• menu

– File – načítanie grafu zo súboru, z databázy, uloženie grafu, uloženie layoutu, ukončenie aplikácie

– Settings – nastavenia aplikácie; konfiguračný súbor používa bodkovú notáciu, ktorá umožňuje identifiko-
vat’ význam konfiguračnej premennej

– Help

– Test - pušt’a základné grafy pre rýchle testovanie (100-uzlový, 500-uzlový, Veolia, Lua-graph)

• hlavné okno - zobrazuje graf a umožňuje s ním používatel’ovi interagovat’

• ovládací panel – nástroje pre prácu s grafom

1.3.1 Ovládacie prvky

Ovládanie kamery:

• Vyber prvkov grafu - l’avé tlačidlo myši + pohyb myšou

• Otáčanie kamery okolo grafu - pravé tlačidlo myši + pohyb myšou

• Ovládanie priblíženia obrazovky - koliesko na myši

• Ovládanie pomocou klávesnici:

– Hore - PgUp

– Dole - PgDn

– Vl’avo - šípka vl’avo

– Vpravo - šípka vpravo

– Dopredu - šípka hore

– Dozadu - šípka dole

Inicializácia automatického pohybu začne po stlačení kláves Alt + Shift a kliknutím myši na zvolenú hranu, či uzol.
V závislosti od nastavenia aplikácie sú pred inicializovaním pohybu ešte automaticky vybrané body záujmu. Pokial’
je automatický výber uzlov vypnutý, body záujmu je možné zvolit’ manuálne myšou alebo stlačením klávesy Q (pre
náhodný výber uzlov alebo pre výber uzlov pomocou metrík). Automatické použitie metrík je možné vypnút’ v
nastavení aplikácie pomocou parametra „Viewer.PickHandler.SelectInterestPoints“ nastaveného na hodnotu 1.

Iné ovládacie prvky:
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• Kláves “T” – skrytie všetkých ovládacích prvkov

• Kláves “S” - štatistiky vykresl’ovania

• Kláves “Shift” - pridávanie d’alších objektov do výberu

• Kláves “Ctrl” - odstránenie objektov z výberu

1.3.2 Záložka GRAPH

- manipulácia s prvkami grafu (no-select mód), pohyb vybraných uzlov v priestore

- výber jedného prvku grafu (single-select mód)

Umožňuje sústredenie sa na práve jeden objekt – môže to byt’ hrana aj uzol.

- výber viacerých prvkov grafu (multi-select mód)

Umožňuje vybrat’ v trojrozmernom zobrazení viacero objektov naraz.

- typ výberu: všetko, iba uzly, iba hrany, klastre

- centrovanie pohl’adu vzhl’adom na vybraný prvok grafu

V prípade, že nie je označený žiadny element, kamera bude vycentrovaná na t’ažisko grafu

- pridanie meta uzla do grafu
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- odstránenie vybraných meta uzlov z grafu

- ukotvenie vybraných uzlov na aktuálnej pozícii, t. j. nebudú sa pohybovat’ v závislosti od pôsobenia síl
ostatných uzlov

- uvol’nenie ukotvených uzlov

- pridanie hrany medzi dvomi vybranými uzlami

Umožňuje pridat’ hranu medzi dvoma vybranými uzlami, kde ešte nie je hrana, inak končí akcia chybovou hláškou.
Ideálne je čiernou šípkou vybrat’ jeden uzol a bielou šípkou ho nastavit’ na také miesto, kde sa ho dá spojit’ s druhým
uzlom - je potrebné mat’ nastavenie Node v takomto prípade spolu s Multi-select mode.

- pridanie uzla do stredu pohl’adu

- odstránenie vybraných elementov (uzly alebo hrany)

Ak sa rozhodneme pre zmazanie hrany, uzly prepojené s touto hranou v grafe zostávajú.

, - zafarbenie zvolených uzlov a hrán farbou vybranou z palety
nad tlačidlom
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- aplikovanie textového označenia na vybrané uzly podl’a textu z pol’a nad tlačidlom

- zapnutie/vypnutie zobrazovania popisov uzlov a hrán

, - spustenie/zastavenie rozmiestňovania (animovania) uzlov grafu

- zmena odpudivých síl pôsobiacich medzi uzlami

- výber vizuálnej reprezentácie uzla (square, sphere) a výber vizuálnej reprezentá-
cie hrany (quad, cylinder, line)

1.3.3 Záložka CONSTRAINTS

– aplikovanie priestorového ohraničenia: povrch gule

- aplikovanie priestorového ohraničenia: obsah gule

- aplikovanie priestorového ohraničenia: rovina
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- aplikovanie priestorového ohraničenia: zjednotenie gule a roviny

Zjednotenie gule a roviny je vhodné pre zobrazenie grafov s hustým stredom, alebo na vel’ké grafy.

- aplikovanie priestorového ohraničenia: kružnica

Aplikovanie obmedzenia na kružnicu na uzly v celom grafe je vhodné pre vel’mi riedke grafy alebo na grafy s pravidel-
nou štruktúrou. Pri hustých grafoch sa hrany medzi uzlami prekrývajú

- aplikovanie priestorového ohraničenia: kužel’

Obmedzenie na kužel’ je vhodným riešením v prípadoch, kedy má jeden uzol výrazne vyšší počet hrán ako ostatné
uzly.

- aplikovanie priestorového ohraničenia: kužel’ový strom

Po aplikácií sa uzly rozdelia do skupín podl’a spoločného rodiča. Na tieto skupiny sa aplikujú obmedzenia na kužel’,
ktoré sú následne obmedzené na roviny v závislosti od hĺbky uzlov v strome. Kužel’ový strom sa aplikuje automaticky
na celý graf na základe používatel’om vybraného koreňového uzla. Jedine v prípade, že graf nie je spojitý, tak sa
aplikuje iba na komponent, ktorý obsahuje koreňový uzol.

- odstránenie vybraných priestorových ohraničení

- aplikovanie priestorového ohraničenia: povrch valca

Vloží do scény tzv. bod záujmu, od ktorého sú uzly zobrazovaného grafu odtláčané do tvaru valca. Polomer valca sa
dá nastavit’ pomocou číselníka.
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- aplikovanie priestorového ohraničenia: povrch kužel’a

Vloží do scény tzv. bod záujmu, od ktorého sú uzly zobrazovaného grafu odtláčané do tvaru kužel’a. Polomer kužel’a
sa dá nastavit’ pomocou číselníka. Vel’kost’ kužel’a sa nastavuje automaticky podl’a toho, kam sa používatel’ prostred-
níctvom kamery pozerá.

- aplikovanie radiálneho rozmiestnenia na označené uzly

Odporúča sa používat’ pri stromovom type grafu. Použitie rozmiestnenia na označené uzly dáva používatel’ovi nové
možnosti ako zväčšenie priestoru označením uzlom, alebo manuálne zhlukovanie uzlov.

- výber módu vykreslenia radiálneho rozmiestnenia (drôtený, plný)

- nastavenie módu 2D/3D radiálneho rozmiestnenia

1. nastavenie vel’kosti rozmiestnenia

2. nastavenie priehl’adnosti rozmiestnenia

3. nastavenie počtu zobrazených gúl’

4. nastavenie faktora zosilnenia odpudivých síl v radiálnom rozmiestnení pre uzly, ktoré nie sú na rovnakej vrstve

5. nastavenie faktora zosilnenia odpudivých síl v radiálnom rozmiestnení pre uzly, ktoré sú na rovnakej vrstve

Vel’kost’ radiálneho zobrazenia sa dá nastavit’ v rozmedzí 0 – 300, parameter priesvitnosti 0 - 100 %, vel’kost’ faktora
zosilnenia odpudivých síl sa nastavuje medzi hodnotami 1 - 5000.
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- prepínač medzi normálnou a vertigo kamerou

Tento mód kamery je vhodné použit’ vtedy, ked’ chce používatel’ menit’ dva rôzne pohl’ady na graf: lokálny pohl’ad,
pri ktorom môže používatel’ s väčšou presnost’ou skúmat’ jednotlivé uzly a vzt’ahy medzi nimi a globálny pohl’ad, pri
ktorom môže používatel’ skúmat’ vzt’ahy medzi uzlami a rozloženie uzlov v daných hĺbkach kostry grafu v globálnom
kontexte.

- zvýšenie vzájomnej vzdialenosti medzi rovinami

- zníženie vzájomnej vzdialenosti medzi rovinami

- pridanie dvoch paralelných rovín

Obmedzenie na roviny sa aplikuje pri grafoch s minimálnou maximálnou hĺbkou kostry grafu hodnoty 2. Koreňový
uzol v kostre grafu určí program - vyberie uzol s najväčším počtom hrán. Pri zrušení obmedzenia sa uzly „odpoja“ od
roviny.

- odobranie dvoch paralelných rovín

- zmena násobiča odpudivých síl medzi uzlami

Násobič odpudivých síl medzi uzlami je na začiatku nastavený na 1 kvôli prvému pridaniu dvoch rovín do priestoru -
nechceme, aby sa hned’ zväčšili odpudivé sily.

- vypnutie všetkých predchádzajúcich obmedzení
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1.3.4 Záložka CLUSTERING

- zlúčenie vybraných uzlov

Umožňuje zlúčit’ vybrané uzly do jedného spoločného uzla. Takýto uzol sa bude v pokračovaní zobrazovat’ modrou
farbou.

- zrušenie zlúčenia vybraných uzlov

- definovanie algoritmu, ktorým sa bude zhlukovat’ graf (adjacency, leafs, neighbours)

- nastavenie počtu rekurzií pre vybraný algoritmus

- spustenie zhlukovania nad aktívnym grafom

Ak zhlukovanie trvá viac ako 1 sekundu, objaví sa indikátor postupu.

1. spustenie algoritmu na zväzovanie hrán

2. pozastavenie algoritmu na zväzovanie hrán

3. úplne zastavenie algoritmu na zväzovanie hrán a zobrazenie pôvodného grafu

4. vstupné pole na zadanie konštanty, určujúcej silu akou sú hrany k sebe počas zväzovacieho algoritmu prit’aho-
vané
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Po použití funkcie zhlukovania, sa odkryjú nasledujúce možnosti:

auto - automatická priehl’adnost’ - mení sa na základe vzdialenosti zhlukov od kamery

selected - priehl’adnost’ označeného zhluku – pomocou posuvníka(nižšie) sa mení priehl’adnost’ len označených zh-
lukov

- posúvaním upravíme priehl’adnost’ označených zhlukov

- posúvaním sa mení prahová hodnota, pri ktorej sa menia tvary zhlukov

Spodné číslo udáva, kol’ko uzlov obsahuje daný zhluk (v tomto prípade 8).

Pri označení konkrétneho zhluku sa odkryjú nasledujúce možnosti:

- kliknutím zmeníme označený zhluk na obmedzovač

Obmedzuje pozície uzlov tak, aby z neho nevyšli von. Ked’ obmedzovač posunieme dostatočne d’aleko, t.j. mimo
pôvodnej pozície uzlov, uzly sa začnú lepit’ na jeho stenu a posúvat’ spolu s ním. Ignoruje prít’ažlivé a odpudivé
sily medzi ním a ostatnými uzlami grafu (posunutie zhluku bez obmedzovača spôsobí posun celého grafu za týmto
zhlukom). Obmedzovač začína svoje pôsobenie ako kocka, je možné zmenit’ jeho tvar nat’ahovaním a stlačením.

- znovurozmiestnenie uzlov v priestore po tom, ako sa nalepia na hranu obmedzovača

- upravenie odpudivej sily medzi uzlami v označenom zhluku

Čím je hodnota väčšia, tým budú uzly d’alej od seba.
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Ďalšie funkcie obmedzovača:

Ak na zhluk zaregistrujeme obmedzovač, môžeme s ním jednoducho pohybovat’ a menit’ jeho tvar pomocou
klávesových skratiek a myši:

• Pohyb – metóda t’ahaj a pust’ ( drag & drop )

• Zmena vel’kosti – držíme Ctrl a točíme kolieskom myši

• Zmena tvaru

– na osy x – držíme X a Ctrl a točíme kolieskom myši

– na osy y – držíme Y a Ctrl a točíme kolieskom myši

– na osy z – držíme Z a Ctrl a točíme kolieskom myši

1.3.5 Záložka CONNECTIONS

- napísanie mena, pod ktorým bude používatel’ vystupovat’ v kolaborácii

- spustenie/zastavenie servera

- napísanie IP adresy servera

- pripojenie(odpojenie) ku(od) kolaborácii

- zoznam používatel’ov (zoradený abecedne), v ktorom je možné jedného vybrat’ a použit’
nasledujúce funkcie:
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- po výbere si môžeme zvolit’ jednu funkciu z dvojice: Spy (špehovat’) a Center (centrovat’).

Po aktivovaní funkcie Spy získa používatel’ pohl’ad iného používatel’a, ktorý je priebežne aktualizovaný – znamená
to, že pohybom sledovaného používatel’a sa aktualizuje aj pohl’ad sledujúceho. Po aktivácii Center nasmeruje pohl’ad
používatel’a tak, aby v jeho strede bol iný používatel’. Pri centrovaní platí to isté, čo pri špehovaní – teda pri aktual-
izácii polohy centrovaného používatel’a sa natáča aj pohl’ad centrujúceho používatel’a. Po označení políčka Shout sa
ostatným používatel’om v scéne zobrazí pri vašom mene ikona znázorňujúca, že sa pokúšate upútat’ pozornost’.

- nastavenie vel’kosti avatarov v scéne

Avatar je kužel’, ktorého kruhová podstava znázorňuje smer, ktorým sa používatel’ pozerá.

1.3.6 Záložka EVOLUTION

- Po rozkliknutí tabu Evolution (1) sa zobrazia možnosti evolúcie

2. Lifespan - možnost’ ponechania vymazaných uzlov vo vizualizácii. Prednastavená hodnota 0 znamená, že vy-
mazané uzly sa automaticky vymažú z grafu. V prípade hodnoty väčšej ako 0 vymazané uzly v grafe zotrvávajú
o verzie dlhšie podl’a nastavenej hodnoty

3. Change commits - prepínač spracovania Git repozitáru. Ak je zaškrtnutý, inicializuje sa spracovanie na úroveň
grafu volaní. V opačnom prípade - na úroveň histórie Git repozitáru

4. Kombo box s výberom vizualizácie - prepínanie sa medzi jednotlivými možnost’ami vizualizácie grafu volaní
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3dSoftViz Documentation, Release v0.1

• LuaStat - vizualizácia softvérových metrík pomocou analýzy Lua zdrojového kódu

• Difference - pohl’ad na zmeny, ktorými softvér prešiel pri prechode na novú verziu

• Changes - aktivovanie filtrovania nad práve aktívnou vizualizáciou

5. Kombo box s výberom filtra - výber vhodnej skupiny filtra

• Prednastavená možnost’ All - všetky prvky grafu sú zobrazené

• Authors - filtrovanie podl’a autorov zmien v softvéri

• Structure - filtrovanie podl’a štruktúry

6. Kombo box zoznamu možností - moznosti zavisia od vybraneho filtru

• zoznam autorov s možnost’ou zobrazenia zmien všetkých autorov - All

• štruktúra - Files (zobrazí v grafe volaní len uzly reprezentujúce adresáre a súbory), Local Functions
(zobrazí rozšírenú možnost’ Files spolu s uzlami lokálnych funkcií), Global Functions (zobrazia sa
uzly možnosti Local Functions spolu s uzlami globálnych funkcií) a Modules (zobrazí všetky štruk-
túry, ktoré sa v grafe nachádzajú)

- panel ovládania evolúcie

1. Prechod na predchádzajúcu verziu - možnost’, kedy sa stav grafu vráti o jednu verziu dozadu

2. Prechod na nasledujúcu verziu - možnost’, kedy sa stav grafu posunie o jednu verziu dopredu

3. Tlačidlo informácií o verzii - zobrazí informácie o aktuálne zobrazenej verzii. Medzi zobrazené informácie patrí
identifikátor, autor a dátum commitu spolu so zoznamom súborov, ktoré boli zmenené

4. Sputenie/zastavenie animácie - aktivovanie/zastavenie automatického prechodu na novú verziu

5. Posuvník - presun na konkrétnu verziu pomocou skokového prechodu medzi verziami

6. Indikátor verzie - poskytuje informáciu o aktuálne zobrazenej verzii

7. Spomalenie animácie - regulovanie rýchlosti animácie

8. Zrýchlenie animácie - regulovanie rýchlosti animácie

1.3.7 Záložka MORE FEATURES

- zapnutie 3D myšky (musí byt’ aktivovaný driver)

- ak je zaškrtnuté, kamera nasmerovaná na graf sa pohybuje na základe pohybu tváre, značky
alebo rúk, inak sa na základe týchto akcií rotuje samotný graf
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- povol’uje použitie kamery

- otvorenie okna pre prácu s kamerou

- otvorenie okna pre prácu s hlasovým ovládaním

Note: Speech je momentálne vylúčený z projektu

- zapnutie ovládania pomocou Leap Senzor–u

Okno pre prácu s kamerou

- prispôsobenie l’avej strany okna pre ovládanie funkcionality rozpoznávania tvare
(pri zapínaní treba zaškrtnút’ Camera rotation a Camera enabled)

- zvolenie kamerového zariadenia a následným potvrdením objavenie záberu z kamery

Ukončit’ túto akciu je možné tlačidlom „StopFaceRec“ (ak používatel’ zatvoril okno, môže ho vrátit’ na grafický
interface opätovným kliknutím na „StartCamera“ a potom pozastavit’ detekciu). V prípade detegovanej tváre (detekcia
je reprezentovaná zeleným obdĺžnikom) sa kamera alebo graf pohybuje vd’aka pohybu tváre.
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- okno pre
výber snímacieho zariadenia

- prispôsobenie l’avej strany okna pre ovládanie funkcionality rozpoznávania značky

- zvolenie kamerového zariadenia a následným potvrdením objavenie záberu z kamery
určenej pre rozpoznávanie značky a graf sa začne otáčat’ a pohybovat’ so značkou

- nastavenie aktuálne snímanie ako pozadie pre graf

Je potrebné zmenit’ parameter „Viewer.SkyBox.Noise“ v konfiguračnom súbore na hodnotu 2 alebo 3 (odporúčané je
3).
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- prepínanie medzi pohybom podl’a značky ako keby sa kamera pozerala na používatel’a a
naopak

- zapnutie korekcie

- nastavenie korekčných parametrov

Podl’a predvolených nastavení sa značka pohybuje tak, ako keby sa kamera pozerala vo vodorovnom smere. Ak by sa
pozerala napr. na stôl pod miernym sklonom dole, graf by sa pri posúvaní značky po stole neposúval korektne. Preto je
možné nastavit’ korekčné parametre. Najskôr je potrebné nastavit’ značku do polohy, kedy je detegovaná na spodnom
okraji a následne stačit’ toto tlačidlo. Po nastavení sa aktivuje opcia „Correction“ (uvedené vyššie), ktorou je možné
zapnút’ korekciu.

- zmena spôsobu použitia značky v prípade, že používatel’ má k dispozícii len jednu značku

- vypnutie/zapnutie zobrazenia videa

Toto prepínanie a vypnutie zobrazenia video má vplyv len na zobrazenie v rámci tohto ovládacieho okna „Face Recog-
nition“ and „Marker Detection“ a neovplyvňuje to ani vol’bu kamery pre video pozadie.
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- Interakcia s vizualizáciou v obohatenej realite

• Možnost’ Custom light, vyznačená modrou, ktorá slúži na prepínanie vlastného a základného zdroja svetla

• Možnost’ Shadow, vyznačená žltou, ktorá slúži na zapínanie a vypínanie generovania tieňov

• Možnost’ Base, vyznačená červenou, ktorá slúži na zobrazenie a skrytie základne

• Možnost’ Axes, vyznačená ružovou, ktorá slúži na zobrazenie a skrytie pomocných osí

• Tlačidlo Center graph, vyznačené svetlo modrou, ktoré slúži na umietnetie grafu nad stred základne

Okno pre prácu s kinectom a arucom

- zapnutie detekcie

- zachytenie kádra s následnou možnost’ou dat’ ho na pozadie

- zapnutie rozpoznávania značiek

- prepínanie medzi detekovaním ruky pre manipuláciu grafu alebo kamery v podobe rotova-
nia a medzi detekovaním ruky pre funkciu “klik” (pohyb ruky do hĺbky, nie vertikálne alebo horizontálne)
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- vypne možnost’ približovania

- nastavenie práce s arucom

- zobrazenie okna projekčného zobrazenia

- v projekcnom zobrazeni - Projector - spinboxy na zmenu parametrov projektora
(odhora) - zorné pole, pozícia (súradnice x, y, z), smer projekcie(súradnice x, y, z)

- v projekcnom zobrazeni - Viewer - spinboxy na zmenu parametrov pozorovatel’a
(odhora) - zorné pole, pozícia (súradnice x, y, z), smer projekcie (súradnice x, y, z)
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- v projekcnom zobrazeni - Graph - spinboxy na zmenu parametrov grafu (odhora)
- pozícia (súradnice x, y, z), polomer, checkbox Place graph na potvrdenie použitia parametrov grafu (štandartne
označený)

- potvrdenie zadaných parametrov scény

Hlasové príkazy pre Speech

• select all nodes - vybratie všetkých uzlov

• select left side - vybratie uzlov na l’avej strany

• select right side - vybratie uzlov na pravej strany

• clear screen - zrušenie vybratia uzlov

• sphere - sformovanie gule pre vybrané uzly

• unset restrictions - návrat k pôvodnému stavu - zrušenie akcie “sphere”

1.3.8 Hlavné okno

- filtrovanie hrán

- filtrovanie uzlov

Príklady príkazov:

• “params.type like ’file’ or params.type like ’directory’”

• “params.name like ’init%.lua’ and params.type like ’function’”

• “params.type like ’function’”
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Filter je navrhnutý pre grafovú vizualizáciu softvéru s využitím softvérových metrík jazyka Lua a je vyhodnotený po
stlačení klávesu „Enter“.

- zobrazí dialóg pre výber súborov a po vybratí vykreslí do pol’a pod tlačidlom graf
volaní funkcií týchto súborov

Pri označení práve jedného vrcholu v poli sa zobrazí stromová štruktúra informácií o tomto vrchole.

- prepínanie medzi zobrazovaním jedného prehliadača pre každý uzol a
zobrazovaním jedného prehliadača pre všetky vyznačené uzly

1.3.9 Git repozitár

1. Settings / Options - zobrazenie dialógového okna s konfiguráciou

2. Možnost’ Git - zobrazia sa možnosti konfigurácie spracovania Git repozitáru

3. Možnosti konfigurácie spracovania Git repozitáru

• vyčlenenie adresárov (ExcludeDirectories) - l’ubovol’ný počet názvov adresárov oddelených znakom
”,”. Pre zadanú hodnotu sa pri spracovaní Git repozitáru odignorujú všetky súbory, ktoré vo svojej
relatívnej ceste obsahujú adresár spec.

• ExtensionFilter - funguje obrátene, pričom ponecháva len tie súbory, ktorých koncovka súboru sa
zhoduje s jednou zo zadaných hodnôt. Hodnota taktiež môže obsahovat’ viacero koncoviek súborov,
pričom musia byt’ oddelené znakom ”,”

1.3. Používatel’ská príručka pre 3D Softviz 39
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1.4 Používatel’ská príručka pre Vuzix a Leap

1.4.1 Stereoskopické 3D s Vuzix okuliarmi

Okuliare

Ako prvé je potrebné pripojit’ Vuzix okuliare k počítaču (HDMI a 2x USB)

Okuliare by mali byt’ rozpoznané ako zobrazovacie zariadenie, pre ktoré nastavte duplikáciu obrazu z monitora, na
ktorom beží 3Dsoftviz.

Nakoniec pomocou ovládacieho zariadenia vyvolajte menu a nastavte režim zobrazovania obrazu na side-by-side 3D
alebo top-bottom 3D, poprípade upravte aj jas a kontrast obrazu.

(menu sa zobrazí len priamo na displejoch okuliarov)

3Dsoftviz

Pre správne zobrazenie je potrebné nastavit’ 3Dsoftviz do režimu plnej obrazovky stlačením klávesy L a skryt’ panel
s nástrojmi stlačením klávesy T

Následne je možné pomocou klávesy G prepínat’ medzi režimami:

• normálne zobrazenie

• top-bottom 3D zobrazenie

• side-by-side 3D zobrazenie

Vyberte zobrazenie korešpondujúce s nastavením okuliarov.

Klávesami H a J je možné upravovat’ nastavenie vzdialenosti očí, ktorá mení posun medzi obrazmi ktorým sa dosahuje
3D efekt. Úprava je po 0.01m a aktuálna hodnota sa zobrazuje v konzole.
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1.4.2 Ovládanie rukami s Leap senzorom

Leap:

Ako prvé je potrebné pripojit’ Leap senzor k počítaču (1x USB). Ďalej je potrebné nainštalovat’ oficiálny softvér k
Leap senzoru z oficiálnej stránky.

3Dsoftviz:

V l’avej lište s nástrojmi je v karte More features možnost’ Start Leap, po stlačení ktorej začne snímanie rúk nad
senzorom.

Podporované je nasledovné ovládanie:

• L’avá ruka s vystretými prstami – pohyb kamery dopredu

• L’avá ruka so skrčenými prstami – zastavenie pohybu kamery

• Pravá ruka s vystretými prstami – kamera sa otáča podl’a naklonenia dlane

Snímanie je možné zastavit’ opätovným stlačením rovnakého tlačidla ktoré ma počas snímania text Stop Leap.

1.4. Používatel’ská príručka pre Vuzix a Leap 41
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CHAPTER

TWO

PRE VÝVOJÁROV

Pomocné materiály pre vývojárov, pracujúcich na projekte.

2.1 UML diagramy

2.1.1 Structural

Class Diagrams

Data

Data:

Data1:

43
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Data.Edge:

Data.Graph:

Data.Node:
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Layout

Layout1:

Layout2:

Layout3:

Layout-Visitor:

2.1. UML diagramy 45
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Layout - complete:

LeapSenzor

LeapThread dedi of QThread - include Leap, LeapController - vytvara samostatny thread pre leap senzor

LeapListener dedi od Listener - include Leap, LeapActions, DirectionDetector, FingerPositionDetector - prekonava
funkcie Listenera ktory sa staraju o zmenu stavu leap senzora

LeapController dedi od Controller - include Leap, LeapListener - spusta a zastavuje pocuvanie leap senzora

LeapAction - include DirectionDetector, MouseControl, CameraManipulator, Leap, Math, Core - Obsahuje funkcie
ktore sa vykonaju na zaklade detekovaneho gesta

FingerPositionDetector - include Leap - obsahuje funkcie na pracu s poziciou prstou

DirectionDetector - include Leap, LeapMath - obsahuje funkcie na pracu s natocenim roznych casti ruky

Network

Network:
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Network (complete):

QOSG

Nove pridane triedy:

2.1. UML diagramy 47
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CoreWindow:

QOSG:

QOSG complete:

Viewer

Viewer1:

Viewer2:
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Viewer3:

Viewer complete:

GitLib

GitLib a 3DSoftViz architektura:

Diagram tried GitLib kniznice:
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Datovy diagram Git:

2.1. UML diagramy 51
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3D Mouse

Linux:

Windows:

2.1. UML diagramy 53
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AppCore:

ArucoModul:
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Clustering:

Importer:

Kinect:
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Lua:

Manager:
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MathModul:

Model:
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Noise:

OpenCV:
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OsgQtBrowser:

QOpenCV:

2.1. UML diagramy 59
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Util:

Component diagrams

Architektura 3dsoftviz:
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2.1.2 Behavioral

Activity diagrams

•

Use-case diagrams

•

Sequence diagrams

GitLua

Git Lua Graph Analyzer:

2.1. UML diagramy 61
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Git Lua Graph Visualizer:
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Statechart diagrams

Camera Movement:

Object diagrams

Graph structure layer0:

Graph structure layer1:
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Graph structure layer2:

Graph structure layer3-Node:

Graph structure layer3-Edge:

Graph structure layer3-handsGroup:
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LeapAR Adapter:
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Api leap library:
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Navrh modelu ruky layer0:
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Navrh modelu ruky layer1:

Implementovany model ruky :
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Volania pri update ruk v scene pri LeapAR:

Mapovanie ruk a update pozadia pri LeapAR :
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2.2 Akceptačné testovanie

2.2.1 Záložka GRAPH

Zoznam
ovládacích
prvkov

Opis funkcionality Sta-
tus

Opis závady

manipulácia s prvkami grafu, nič
neoznačuje

funkčné

výber jedného prvku grafu funkčné

výber viacerých prvkov grafu funkčné

centrovanie pohl’adu vzhl’adom na
vybraný prvok grafu

funkčné

typ výberu prvku grafu: všetko, iba
uzly, iba hrany, klastre

funkčné

pridanie meta uzla do grafu funkčné

odstránenie vybraných meta uzlov
z grafu

ne-
funkčné

meta uzol sa nedá odstránit’ zo scény

ukotvenie vybraných uzlov na
aktuálnej pozícii

funkčné

uvol’nenie ukotvených uzlov funkčné

pridanie hrany medzi dvomi vybranými
uzlami

funkčné

pridanie uzla funkčné

odstránenie vybraných elementov (uzly
alebo hrany)

funkčné

výber farby pre zafarbenie uzla ne-
funkčné

nedá sa vybrat’ iná farba ako čierna

aplikovanie vybranej farby na vybraný
uzol

funkčné

aplikovanie textového označenia na
vybrané uzly podl’a textu

ne-
funkčné

uzol sa po aplikovaní zmenší a táto
akcia sa nedá vrátit’ spät’

zapnutie/vypnutie zobrazovania
popisov uzlov a hrán

funkčné

spustenie animovania rozmiestňovania
uzlov grafu

funkčné

zastavenie animovania rozmiestňovania
uzlov

funkčné

zmena odpudivých síl pôsobiacich
medzi uzlami

funkčné

76 Chapter 2. Pre vývojárov



3dSoftViz Documentation, Release v0.1
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2.2.2 Záložka CONSTRAINTS

Zoznam ovládacích
prvkov

Opis funkcionality Status Opis závady

aplikovanie priestorového
ohraničenia: povrch gule

funkčné

aplikovanie priestorového
ohraničenia: obsah gule

funkčné

aplikovanie priestorového
ohraničenia: rovina

funkčné

aplikovanie priestorového
ohraničenia: prienik gule
a roviny

funkčné

aplikovanie priestorového
ohraničenia: kružnica

nefunkčné nedá sa zmenit’ priemer
kružnice, po pokuse
zmenit’ priemer, ne-
funguje odstránenie
ohraničenia

aplikovanie priestorového
ohraničenia: kužel’

funkčné

aplikovanie priestorového
ohraničenia: kužel’ový
strom

funkčné

odstránenie vybraných
priestorových ohraničení

funkčné

aplikovanie priestorového
ohraničenia: povrch valca

funkčné

aplikovanie priestorového
ohraničenia: povrch
kužel’a

funkčné

aplikovanie radiálneho
rozmiestnenia na oz-
načené uzly

funkčné

výber módu vykreslenia
radiálneho rozmiestnenia
(drôtený, plný)

funkčné

nastavenie módu 2D/3D
radiálneho rozmiestnenia

funkčné

1. nastavenie vel’kosti
rozmiestnenia

2. nastavenie
priehl’adnosti
rozmiestnenia

3. nastavenie počtu
zobrazených gúl’

4. nastavenie fak-
tora zosilnenia
odpudivých síl v
radiálnom rozmi-
estnení pre uzly,
ktoré nie sú na
rovnakej vrstve

5. nastavenie fak-
tora zosilnenia
odpudivých síl v
radiálnom rozmi-
estnení pre uzly,
ktoré sú na rovnakej
vrstve

funkčné

prepínač medzi normál-
nou a vertigo kamerou

funkčné

zvýšenie vzájomnej vzdi-
alenosti medzi rovinami

funkčné

zníženie vzájomnej vzdi-
alenosti medzi rovinami

funkčné

pridanie dvoch paralel-
ných rovín

funkčné

odobranie dvoch paralel-
ných rovín

funkčné

zmena násobiča odpudi-
vých síl medzi uzlami

nefunkčné zmenou hodnoty sa uzly
nehýbu

vypnutie všetkých pred-
chádzajúcich obmedzení

funkčné
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2.2.3 Záložka CLUSTERING

Zoznam ovládacích
prvkov

Opis funkcionality Status Opis závady

zlúčenie vybraných uzlov funkčné

zrušenie zlúčenia vy-
braných uzlov

funkčné

definovanie algoritmu,
ktorým sa bude zhlukovat’
graf

funkčné

nastavenie počtu rekurzií
pre vybraný algoritmus

funkčné

spustenie zhlukovania nad
aktívnym grafom

funkčné

1. spustenie algoritmu
na zväzovanie hrán

2. pozastavenie algo-
ritmu na zväzovanie
hrán

3. úplne zastave-
nie algoritmu
na zväzovanie
hrán a zobrazenie
pôvodného grafu

4. vstupné pole na
zadanie konštanty,
určujúcej silu akou
sú hrany k sebe
počas zväzova-
cieho algoritmu
prit’ahované

funkčné

Po použití funkcie zhlukovania, sa odkryjú nasledujúce možnosti:
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Zoznam ovládacích
prvkov

Opis funkcionality Status Opis závady

auto - automatická
priehl’adnost’ - mení sa
na základe vzdialenosti
zhlukov od kamery
selected - priehl’adnost’
označeného zhluku

funkčné

pomocou posuvníka sa
mení priehl’adnost’ len
označených zhlukov

funkčné

posúvaním sa mení pra-
hová hodnota, pri ktorej
sa menia tvary zhlukov -
spodné číslo udáva, kol’ko
uzlov obsahuje daný zh-
luk

funkčné

Pri označení konkrétneho zhluku sa odkryjú nasledujúce možnosti:

Zoznam
ovládacích
prvkov

Opis funkcionality Sta-
tus

Opis závady

kliknutím zmeníme označený zhluk na obmedzovač ne-
funkčné

pri pokuse o otestovanie
program spadne

znovurozmiestnenie uzlov v priestore po tom, ako sa
nalepia na hranu – obmedzovača

neotesto-
vané

nie je možné otestovat’
kvôli problému s
Restrict

upravenie odpudivej sily medzi uzlami v označenom
zhluku - čím je hodnota väčšia, tým budú uzly d’alej od
seba

neotesto-
vané

nie je možné otestovat’
kvôli problému s
Restrict
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2.2.4 Záložka CONNECTIONS

Zoznam ovládacích
prvkov

Opis funkcionality Status Opis závady

meno, pod ktorým bude
používatel’ vystupovat’ v
kolaborácii

funkčné

spustenie/zastavenie
servera

funkčné

IP adresa servera funkčné

pripojenie(odpojenie)
ku(od) kolaborácii

funkčné

zoznam používatel’ov funkčné

Spy - získa používatel’ po-
hl’ad iného používatel’a
Center - nasmeruje po-
hl’ad používatel’a tak, aby
v jeho strede bol iný
používatel’
Shout - iným použí-
vatel’om sa v scéne
zobrazí pri vašom mene
ikona znázorňujúca,
že sa pokúšate upútat’
pozornost’

funkčné

nastavenie vel’kosti
avatarov v scéne

funkčné
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2.2.5 Záložka MORE FEATURES

Zoznam
ovládacích
prvkov

Opis funkcionality Sta-
tus

Opis závady

ak je zaškrtnuté, kamera nasmerovaná a graf sa pohybuje na
základe pohybu tváre, značky alebo rúk, inak sa na základe týchto
akcií rotuje samotný graf

funkčné

povol’uje použitie kamery funkčné
otvorenie okna pre prácu s kamerou funkčné
otvorenie okna pre prácu s hlasovým ovládaním neotesto-

vané
Speech je
momentálne
vylúčený z
projektu

zapnutie ovládania pomocou Leap Senzoru funkčné

Možnosti okna otvoreného po kliknutí na vyššie uvedené tlačidlá:

82 Chapter 2. Pre vývojárov



3dSoftViz Documentation, Release v0.1

Zoznam
ovládacích
prvkov

Opis funkcionality Sta-
tus

Opis závady

prispôsobenie l’avej strany okna pre ovládanie funkcionality
rozpoznávania tváre

funkčnétreba pri zapinani
zaskrtnut Camera
rotation a Camera
enabled

zvolenie kamerového zariadenia a následným potvrdením
objavenie záberu z kamery s rozpoznávaním tváre (graf sa
pohybuje na základe pohybu tváre)

funkčné

prispôsobenie l’avej strany okna pre ovládanie funkcionality
rozpoznávania značky

funkčné

zvolenie kamerového zariadenia a následným potvrdením
objavenie záberu z kamery určenej pre rozpoznávanie značky a
graf sa začne otáčat’ a pohybovat’ so značkou

funkčné

nastavenie aktuálne snímanie ako pozadie pre graf funkčné
prepínanie medzi pohybom podl’a značky ako keby sa kamera
pozerala na používatel’a a naopak

neotesto-
vané

nepodarilo sa vykonat’
test

nastavenie korekčných parametrov neotesto-
vané

nepodarilo sa vykonat’
test

zmena spôsobu použitia značky v prípade, že používatel’ má k
dispozícii len jednu značku

funkčné

vypnutie/zapnutie zobrazenia videa funkčné
zapnutie detekcie Kinectom funkčné
zachytenie kádra s následnou možnost’ou dat’ ho na pozadie neotesto-

vané
nepodarilo sa vykonat’
test

prepínanie medzi detekovaním ruky pre manipuláciu grafu
alebo kamery v podobe rotovania a medzi detekovaním ruky
pre funkciu “klik” (pohyb ruky do hĺbky, nie vertikálne alebo
horizontálne)

funkčné

vypnutie možnosti približovania funkčné

nastavenie práce s arucom (manipulácia grafu pomocou
značiek)

funkčné

2.2. Akceptačné testovanie 83



3dSoftViz Documentation, Release v0.1

2.2.6 Hlavné okno

Zoznam
ovládacích
prvkov

Opis funkcionality Sta-
tus

Opis závady

filtrovanie hrán funkčné nefunguje na
operačnom systéme
Windows

filtrovanie uzlov funkčné nefunguje na
operačnom systéme
Windows

zobrazí dialóg pre výber súborov; po vybratí vykreslí do
pol’a pod tlačidlom graf volaní funkcií týchto súborov

funkčné nefunguje na
operačnom systéme
Windows

prepínanie medzi zobrazovaním jedného prehliadača pre
každý uzol a zobrazovaním jedného prehliadača pre
všetky vyznačené uzly

funkčné nefunguje na
operačnom systéme
Windows

File – načítanie
grafu zo súboru

načítanie grafu do scény funkčné

File - načítanie
grafu z databázy

načítanie grafu do scény neotesto-
vané

nie sú k dispozícii
grafy v databázovej
podobe

File - uloženie
grafu

uloží graf neotesto-
vané

možnost’ bola
implementovaná pre
databázové riešenie

File - uloženie
layout

ponúkne možnost’ nazvat’ layout a uloži ho neotesto-
vané

možnost’ bola
implementovaná pre
databázové riešenie

File - ukončenie
aplikácie

ukončí aplikáciu funkčné

Settings nastavenia jednotlivých parametrov aplikácie funkčné

2.3 Logovacie a benchmarkingové knižnice

2.3.1 Logovacie knižnice

Pri použití Easylogging++:

• #include “easylogging++.h” len tam kde treba použit’

• INITIALIZE_EASYLOGGINGPP je len raz v main-e

Zdroje:

• Loguru

• Logog

• Spdlog

• Plog

• Easyloggingpp
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• G3log

• Glog

• log4cpp

• log4cplus

• log4cxx

• BOOSTlog

2.3.2 Benchmarkingové kniznice

Celero je najlepším výberom, len potrebuje C++11 compiler.

Pre iné platformy ako Windows je možné použit’ Hayai.

Zdroje:

• Hayai

• Celero

• Nonius

• Googlebenchmark

2.4 Metodiky

2.4.1 Ako programovat v C++

Ako pisat headre a cpp subory

includuje sa v tomto poradi (plati pre .h aj .cpp):

• headre z projektu

• headre z Qt a OSG

• systemove headre

v .cpp je prvy header prislusne .h-cko toho .cpp

Important: pravidlo: includujem najprv tie, ktore mozu includnut co najviac

pravidla pre pisanie .h

• obsahuju iba defincie metod, NIE implementaciu metod

• includujeme LEN co je treba pre header, NIC naviac

• ak je v triede/metode pouzity pointer typ, napr.
Node* n;
tak staci pouzit doprednu deklaraciu, t.j.
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class Node;
a netreba includovat Node.h

Attention: toto nefunguje, ked:

• sa dedi trieda

• to neni pointer, t.j. je to Node n;

• ked je pouzity osg::ref_ptr pointer, resp. templaty

pravidla pre pisanie .cpp

ak je typ premennej pouzity LEN v .cpp (typicky lokalna premenna v metode),
tak prislusny header davame len do .cpp

ZLE praktiky, resp. co nerobit

NIKDY v headroch a cpp suboroch nepouzivat “using namespace”

• nepouzivat “using” keyword

ak uz je pouzite, tak to treba upravit na :

namespace XYZ {
... implementacia ...

}

NEPOUZIVAT “0” (nulu) ako NULL pointer, ale

• pouzit nullptr (ak kompilator podporuje C++11), pripadne pouzit NULL

DOBRE praktiky, resp. co robit

inicializovat VSETKY atributy “pri” konstruktore cez “initialization list”

• najme pointre

– skontrolvat ak je “new” v konstruktore, tak MUSI byt “delete” v destruktore (neplati
pre: osg::ref_ptr)

• inicializovat v takom poradi v akom su zapisane v triede:

– usporiadat atributy od “najvacsich” (napr. pointer, trieda, double) po “najmensie” (int, char, bool)
aj ked sa bude mixovat public/private

“std::cout”

• pokial je v kode, ktory pouzva Qt, tak prerobit na qDebug

• resp. najst a pouzivat nejaku externu kniznicu na logovanie

Ak sa pouzije cudzi existujuci kod tak, ze sa priamo jeho zdrojaky pridaju do existujuceho projektu

• tak treba aby zozstal povodny a upravy sa riesili napr. v zdedenej triede

WARNING-y - opravuju sa vsetky warningy v nasom kode (minimalizacia moznych problemov)

pravidelne sa robi staticka analyzka kodu pomocou nastrojov cppcheck a cpplint
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• vid. metodiky ccpchceck, cpplint

pravidelne sa zdrojovy kod formatuje pomocou nastroja astyle

pravidelne sa merguju vsetky prace

2.4.2 CppCheck

Stiahni a extrahuj: http://cppcheck.sourceforge.net

pouzite cppcheck v 1.70

Ako pouzivat v default GUI

1. v Edit->Preferences nastavit: General: check “Force checking all #ifdef configurations” Paths: pridat cestu
do “3dsoftviz/include” Advanced: check “Show inconclusive errors” !!! toto hlasi dost false-positive, ALE
obcas najde dolezite veci !!!

2. Check->Directory a vybrat “3dsoftviz/src”

Ako pouzivat v QTCreatore (Windows)

1. Pridaj cestu k cppcheck-u do systemovej premennej PATH: (napr. d:/timak/cppcheck)

2. V run_cppcheck.bat (root adresar projektu) zmen set cppcheck_path= ../cppcheck.exe na celu cestu k cp-
pcheck.exe

3. Spusti QTCreator

4. Projects -> Build & Run -> Build

5. V Build Settings -> Edit Build configuration klikni Add -> clone selected a zadaj “cppcheck”

6. V Build steps rozklikni Details a v Targets oznac “cppcheck”. Ak su oznacene aj ine targety, tak ich je potrebne
odznacit(Vysledok: Make: jom.exe cppcheck).

7. Klikni na kladivko v lavom dolnom rohu (Build).

8. Vystupom je subor cppcheck-report.txt v podadresari _build

poznamky k reportom: !!! ak je nieco nejasne, treba sa opytat !!!

!!! ignorovat hlasky pre externy kod: !!! noiseutils, qtcolorpicker

dolezite hlasky typu:

Technically the member function XYZ can be const.

• najma funkcie typu “getter” mozu byt const, napr.:

int getX () const {
return 1;

}

Technically the member variable XYZ can be const.

• treba skontrolovat!!!

The class ‘RestrictionsManager’ does not have a constructor.
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• kazda trieda by mala mat konstruktor (kompiler nam sice vytvori defaul, ale... vid. nizsie)

‘class Type’ does not have a copy constructor which is recommended since the class contains
a pointer to allocated memory.

• zavisi, ci sa “copy constructor” v kode pouziva - nutna kontrola

The scope of the variable ‘gesto_hore’ can be reduced.
Variable ‘gesto_hore’ is assigned a value that is never used.

• to je jasne

C-style pointer casting

• to je riesene aj cez cpplint v samostatnej hotfix branch

• v gcc da sa zapnut -Wold-style-cast -> momentalne hlasi velmi vela warningov

• je to kvoli citatelnosti, ALE ma to svoje opodstatnenie

Member variable ‘Cube::at’ is not initialized in the constructor.

• vsetky class variables by mali byt inicializovane v konstruktore cez “initialization list”

!!! najma pointre !!! na NULL, resp. cez new (a delete v destructore)

Possible null pointer dereference: conn - otherwise it is redundant to check it against null. Possible leak
in public function. The pointer ‘nodeTypeComboBox’ is not deallocated before it is allocated.

!!! treba skotrolovat - indikuje zavanu chybu !!!

Uninitialized variable: newGraph

!!! treba skotrolovat - indikuje zavanu chybu !!!

ostatne hlasky:

• treba skontrolovat - a mali by sa opravit

2.4.3 Cpplint

Cpplint

je to Python script

• pokial by bol problem spustat, mozem to riesit ja

ako pouzivat v QTCreatore (Windows)

1. Stiahni a nainstaluj python (napr. verziu 2.7)

2. Ako administratorspusti prikaz: pip install cpplint

3. Najdi lokaciu kde sa to nainstalovalo. Pravdepodobne: c:/Python27/Scripts/cpplint.exe V cpplint.bat (root
adresar projektu) zmen set cpplint_path= ../cpplint.exe na celu cestu ku cpplint.exe

4. Spusti QTCreator

5. Projects -> Build & Run -> Build
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6. V Build Settings -> Edit Build configuration klikni Add -> clone selected a zadaj “cpplint”

7. V Build steps rozklikni Details a v Targets oznac “cpplint”. Ak su oznacene aj ine targety, tak ich je potrebne
odznacit(Vysledok: Make: jom.exe cpplint).

8. Klikni na kladivko v lavom dolnom rohu (Build).

9. Vystupom je subor cpplint-report.txt v podadresari _build

ako pouzivat (Linux)

pouzite testy su nastavene v CPPLINT.cfg

dostupne testy sa vypisu: cpplint.py –filter=

spustit v include adresari: cpplint.py Aruco/* Core/* Data/* Importer/* Layout/* Math/* Network/*
Network/executors/* OpenCV/* QOpenCV/* Speech/* Viewer/* Clustering/* Clustering/Figures/*
Fglove/* Kinect/* Kinect/RansacSurface/* Manager/* Model/* OsgQtBrowser/* QOSG/* Util/*
2>&1 | tee report-include.txt

spustit v src adresari: cpplint.py Aruco/* Core/* Data/* Importer/* Layout/* Math/* Network/* Net-
work/executors/* OpenCV/* QOpenCV/* Speech/* Viewer/* Clustering/* Clustering/Figures/*
Fglove/* Kinect/* Kinect/RansacSurface/* Manager/* Model/* OsgQtBrowser/* QOSG/* Util/*
2>&1 | tee report-src.txt

poznamky k reportom

!!! ak je nieco nejasne, treba sa opytat !!!

ignorovat hlasky pre externy kod: noiseutils, qtcolorpicker

ciastocne pre cameramanipulator, QGraphicsViewAdapter

dolezite hlasky typu:

Constructors callable with one argument should be marked explicit

• nastudovat, asi staci pridat keyword explicit

Is this a non-const reference? If so, make const or use a pointer

• nastudovat (ci to nieje false-positive)

Use int16/int64/etc, rather than the C type long

• nastudovat

Do not use namespace using-directives.

• odstranit “using namemspace” (okrem externeho/cudieho kodu )

Consider using rand_r(...) instead of rand(...) for improved thread safety.

• kedze mame vlakna, asi by bolo vhodne. vid.: https://stackoverflow.com/questions/
3973665/how-do-i-use-rand-r-and-how-do-i-use-it-in-a-thread-safe-way

Are you taking an address of a cast? This is dangerous: could be a temp var. Take the address
before doing the cast, rather than after

!!! indikuje vazny problem !!!

flase-positive:
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Clustering/Figures/Cube.h:28: Add #include <algorithm> for transform [build/include_what_you_use] [4]
Cube ma metodu tranform -> netreba include

ostatne hlasky:

• treba skontrolovat - a mali by sa opravit (resp. uz som ich opravil ;-)

2.4.4 CodeReview

Ako skontrolovat vytvoreny kod

Kontrola kodu zahrna aplikaciu predchadzajucich metodik:

• Ako programovat v C++,

• CppCheck,

• Cpplint,

• upravu kodu pomocou astyle

Vysledny kod musi byt skompilovatelny a CppCheck a Cpplint nesmia zistit ziadne problemy.

2.4.5 AStyle

Ako pouzivat v QTCreatore (Windows)

1) Stiahni AStyle do priecinku s programmi tykajucim sa projektu $ASTYLE_PATH. 1) Pridaj cestu k astyle-u do
systemovej premennej PATH: $ASTYLE_PATH/bin (napr. d:/timak/AStyle/bin) 3) Spusti QTCreator 4) Projects ->
Build & Run -> Build 5) V Build Settings -> Edit Build configuration klikni Add -> clone selected a zadaj “style”
6) V Build steps rozklikni Details a v Targets oznac “style”. Ak su oznacene aj ine targety, tak ich je potrebne
odznacit(Vysledok: Make: jom.exe style). 7) Klikni na kladivko v lavom dolnom rohu (Build).

2.4.6 Metodika tvorby a údržby UML diagramov prostredníctvom PlantUML

PlantUML

PlantUML je jednoduchý program na tvorbu UML diagramov prostredníctvom ich textového opisu. K samotnému
programu prislúcha aj rozsiahla dokumentácia.

PlantUML je vol’ne dostupný na stiahnutie z oficiálnej stránky, prípadne je možné na otestovanie použit’ aj jednoduchú
web aplikáciu.

Pre plnohodnotné využitie je potrebné mat’ taktiež nainštalovaný Graphviz.

Tiež ponúka možnost’ integrácie s viacerými textovými editormi a wiki stránkami.

Pravidlá pre tvorbu súborov

1. Každý diagram sa nachádza v samostatnom textovom súbore (koncovka .txt, resp .wsd pri použití integrácie so
sublime text).

2. Vygenerovaný diagram má identický názov ako prislúchajúci textový súbor (koncovka .png).
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3. Názvy súborov sú po anglicky.

Užitočné príkazy a postupy

Odstránenie duplicity pomocou Preprocesoru

Pri písaní diagramov, ktoré obsahujú komplikované vzt’ahy medzi entitami môžeme narazit’ na situáciu, kde budeme
vel’a krát za sebou písat’ ten istý názov triedy alebo metódy. S využitím makier preprocessoru môžeme túto duplicitu
l’ahko odstránit’.

@startuml
'Bez proprocesoru

package "class Filter representation" {
class ObjectStructure
class Element {

+{abstract}register(Visitor v)
}
class Mapper {

+register(Filter f)
}
class Klient
class Visitor {

+{abstract}visitMapper(Mapper m)
}
class Filter {

+visitMapper(Mapper m)
}

ObjectStructure -down-> Element
Mapper -up-|> Element

ObjectStructure <-left- Klient

Klient -down-> Visitor
Filter -up-|> Visitor

}
@enduml

@startuml
'S preprocesorom
!define o(x) ObjectStructure
!define e(x) Element
!define m(x) Mapper
!define k(x) Klient
!define v(x) Visitor
!define f(x) Filter

package "class Filter representation" {
class o()
class e() {

+{abstract}register(v(x) v)
}
class m() {

+register(Filter f)
}
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class k()
class v() {

+{abstract}visitMapper(m(x) m)
}
class f() {

+visitMapper(m(x) m)
}

o() -down-> e()
m() -up-|> e()

o() <-left- k()

k() -down-> v()
f() -up-|> v()

}
@enduml

V oboch prípadoch bude výsledok nasledovný:

V druhom prípade sa rozhodne menej napíšeme a máme možnost’ menit’ použité názvy tried na jednom mieste
namiesto toho aby sme ich museli menit’ všade. Stojí za poznámku, že každé definované makro musí mat’ parameter
(v našom prípade x, z ktorého ajtak nečítame). Viac o Preprocesore na tejto stránke.
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Použitie aliasov v sekvenčnom diagrame

V sekvenčných diagramoch odporúčame pri definovaní volaní medzi objektami používat’ aliasy (skratky). Ich princíp
je analogický s predchádzajúcim makrom avšak sú ešte o niečo prehladnejšie. Aliasy nie sú však podporované v class
diagrame.

@startuml
participant Client as c
participant Server as s

title sd Basic Server call

activate c
c -> s: sendMessage("You are awesome!")
activate s

s --> c: result = "ok"
deactivate s

deactivate c

@enduml

Výsledok:

Užitočnost’ týchto skratiek (a makier) pochopitel’ne narastá s narastajúcou komplexitou daného diagramu.

Pravidlá pre súborovú štruktúru

Samotné UML diagramy je potrebné rozdelit’ do prehl’adnej súborovej štruktúry:

• projekt (názov projektu, napr. 3dsoftviz)

– doc (inštalačná dokumentácia, vygenerovaná dokumentácia atd’.)

– uml

* structural

· class diagrams (korešpondujúce s reálnym kódom)

· component diagrams

* behavioral

· activity diagrams
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· use-case diagrams

· sequence diagrams

· state diagrams

2.4.7 Gitflow metodika

Forkovanie na GitHub-e

Fork na GitHub-e neprenesie tag-y do forknuteho repozitara, treba ich rucne preniest, v novom repozitari:

• git remote add povodny-repozitar git@github.com:povodny-repozitar/nazov_repo.git

• git fetch povodny-repozitar ‘refs/tags/:refs/tags/ ‘

• git push –tags

Vetvy

• Master - hlavny projekt

• Develop - branchnuta z mastra, kazdy sprint ma vlastnu Develop vetvu, na konci sprintu sa mergne spat do mastra,
!!! pred mergom treba spravit komplet build (nie len unity)

• Feature - branchnuta z developu, kazdy novy kus funkcionality (task v issue tracking nastroji), ktory sa kodi
musi mat vlastnu

– Feature vetvu... po dokonceni a validaci kodu sa mergne spat do Developu, NEINTERAGUJE S MASTER
VETVOU

• Hotfix - vetva na rychly fix priamo z mastera, merguje sa do mastera AJ developu, navysuje aktualnu verziu

Vzdy mergujeme cez Shell a s prepinacom –no-ff

Cheat sheet so vsetkymi zakladnymi commandmi: https://training.github.com/kit/downloads/github-git-cheat-sheet.
pdf

Pull requesty

Po dokonceni prace, ked sme ready to review sa dava pull request na vetvu, do ktorej sa bude mergovat.

Pull request sa robi z GUI GitHubu (pravy horny roh), alebo $ git request-pull {meno_commitu} {URL} (doporucujem
robit cez GUI)

Po odsuhlaseni Pull requestu sa potom pristupi k mergu.

Obrazok ilustruje vytvorenie feature branch z develop vetvy, implementaciu rozdelenu do znazornenych commitov,
nasledny pull request predstavujuci ziadost o code review a finalny merge do develop vetvy daneho sprintu.
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Commit messages

v Commit messages pouzivame tagy a ID ulohy na zaciatok:

• [FIX] - fixli sme nejaku chybu z minula, bugfix, hotfix a podobne

• [ADD] - pridali sme novu funkcionalitu, subor, ...

• [DOC] - pridali sme dokumentaciu, komenty...

• [REF] - pre refactoring

• [FMT] - formatovanie textu, uprava

• [TEST] - pre testy

Za tym velmi strucne (a vystizne) opiseme, ake zmeny sme spravili. Message by mali byt kratke, no pokryvat vsetko,
co sme v commite spravili. **!!! vseobecny tvar: “[tag] #taskId Popis vykonanej zmeny” ** Napr. [DOC] #3654
Pridanie uvadzania ID ulohy do gitflow metodiky

Useful commands

• $ git submodule update –init –recursive

– update submodulov (dependencies)

• $ git checkout -f meno_branch

– checkout branche aj napriek lokalnym zmenam, budu zahodene

• $ git status

– vypise vsetky vykonane zmeny

• $ git stash / $ git stash pop

– ulozi stav projektu do stashu, z ktoreho sa da potom tento stav pop-nut, dobre na prenos zmien medzi
vetvami

Tvorba feature branch-u:

• $ git checkout -b “feature/meno-feature” develop //Switched to a new branch “feature/meno-feature”

Mergovanie hotoveho feature:

• $ git checkout develop //Switched to branch ‘develop’

• $ git merge –no-ff meno-feature

• $ git push origin develop

Tvorba hotfix branch-u:

• $ git checkout -b “hotfix/nazov-co-fixujem” master //Switched to a new branch “hotfix-{cislo_verzie}”

• $ git commit -m “sprava, co som spravil”
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Uzatvorenie Hotfix branchu:

• $ git checkout develop //Switched to branch ‘develop’

• $ git merge –no-ff “hotfix/nazov-co-fixujem”

2.4.8 Sphinx dokumentacia

Instalacia

Python

• Pre pracu so Sphinxom treba mat nainstalovany Python.

Note: Python ponuka verzie 2.x a 3.x. Sphinx 1.3 moze bezat pod Python 2.6, 2.7, 3.3, 3.4, ale odporucana verzia je
2.7.

• Pre stahnutie a instalovanie externych kniznic pre Python existuje prikaz pip. Prikaz uz sa nachadza v oficialnych
verziach Pythonu 3.4.0 alebo 2.7.9.

Ak prikaz sa nenainstaloval automaticky, treba ho stiahnut zo stranky https://bootstrap.pypa.io/
get-pip.py a niekam ulozit. V prikazovom riadku treba prejst do adresara s get-pip.py a spustit nasle-
dovny prikaz:

python get-pip.py

Sphinx

• Prejst do priecinku s dokumentaciou (tam kde index.rst sa nachadza) a pomocou prikazu pip nainstalovat Sphinx:

pip install sphinx

– (sphinx-doc.org)
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• Ak treba vytvorit novu dokumentaciu, pre nastavenie zdrojoveho adresara a vytvorenie potrebnych suborov na
pracu so Sphinx treba spustit prikaz

sphinx-quickstart

a odpovedat na otazky. Vyberte si vsetky predvolene odpovede a po vyzve zadajte nazov, autorov a verziu
projektu.

• Tymto prikazom budu vygenerovane subory Makefile, make.bat a conf.py.in.

– Vsetky konfiguracie dokumentacie su v conf.py.in.

Attention: Sphinx-quickstart a vytvaranie tychto suborov generuju novu dokumentaciu! Ak subory index.rst,
Makefile, make.bat a conf.py.in uz existovali, tak sa prepisu!

• Sphinx dokumentacia generuje vystup v roznych formatoch zo suborov .rst. Podrobnejsie o RestructuredText.

HTML dokumentacia

• Subor make.bat povoli vygenerovat dokumentaciu v tom formate, ktory potrebujete

• Pre generovanie HTML dokumentacie treba v prikazovom riadku prejst do priecinku s ReST subormi a make.bat
suborom a spustit prikaz

make html

• Inak generovanie dokumentacie sa da spustit pomocou CMake v QtCreatore

PDF dokumentacia

Pre generovanie PDF dokumentacie potrebujeme najprv vytvorit Latex dokumentaciu.

Note: Pre pracu s Latex treba mat TeXlive

Prikazom

make latex

vygeneruje sa Latex dokumentacia, ktora nasledne sa moze konvertovat do PDF pomocou programu TeXstudio.

Note: PDF dokumentacia generuje len pomocou prikazoveho riadku a externeho programu, neda sa spustat cez
CMake!

PlantUML

Pre pracu s PlantUML nastrojmi v Sphinx treba:

• nainstalovat Javu

• pridat Javu do premennych prostredi (environment variable)

• nainstalovat Graphviz
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– odporucana verzia je 2.28

• pridat Graphviz do premennych

Note: Hodnota premennej ma byt do dot.exe

• pridat Graphviz do extensions v conf.py.in:

extensions = ['sphinx.ext.graphviz']

• nainstalovat sphinxcontrib-plantuml zo stranky alebo prikazom

pip install sphinxcontrib-plantuml

• pridat pantuml do extensions v conf.py.in:

extensions = ['sphinxcontrib.plantuml']

• stiahnut plantuml.jar

• pridat do conf.py.in prikaz

plantuml = 'java -jar /cesta/do/plantuml.jar'

Attention: Dolezite je zmenit tuto cestu na spravnu, aku mate aktualnu na Vasom pocitaci!

• pridavat UML do dokumentacii je mozne pomocou

.. uml::

!include /cesta/do/subor.wsd(txt)

alebo

@startuml
PlantUML kod
@enduml

Excel tabulky

• Pre import Excel suborov do dokumentacie treba nainstalovat exceltable pomocou prikazu
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pip install sphinxcontrib-exceltable

• Pridat exceltable do extensions v conf.py.in:

extensions = ['sphinxcontrib.exceltable']

• Importovat tabulky pridanim do .rst suboru:

.. exceltable:: caption
:file: path/to/document.xls
:header: 1
:selection: A1:B2

• Podrobnejsie o Options

2.4.9 TFS metodika

Všeobecná metodika na manažment úloh v tíme

Pridanie novej úlohy

• Uviest’ ohodnotenie úlohy, priority, opis, uviest’ kedy je úloha hotová.

• Uviest’ odhadovaný čas dokončenia.

• Opis musí byt’ podrobný, aby každému členovi bolo jasné, čo ma vykonat’ po pridelení úlohy.

Rozdel’ovanie úloh

• Každý si vyberie (potiahne) úlohu/úlohy, ktorá/é majú najvyššiu prioritu.

• Ak ostanú nepridelené úlohy, študentský vedúci tímu pridelí členom zvyšné úlohy.

Kedy je úloha hotová

• Dokumentácia: Ked’ je znovu vygenerovaná.

• Kód: Potrebné spravit’ code review a vykonat’ pull request do vetvy, ktorá sa bude mergovat’.

• Testy: Ked’ je spravený report z testu.

• Zápisnica: Ked’ je nahratá vo formáte pdf na stránke tímu.

TFS metodika

• Adresa TFS: https://tfs.fiit.stuba.sk:8443/tfs/ (Potrebné sa lognút’ 2x)

• Projekt: AugReality / AugReality Team
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Pridávanie úloh

• Úlohy podobného charakteru priradíme do spoločného backlog itemu.

• Pri pridávaní úlohy sa automaticky nastaví stav ‘To Do’.

• V prípade objavenia chyby, je potrebné vytvorit’ novú úlohu typu Bug (Chyba)

Úlohy (tasky) sa môžu nachádzat’ v troch stavoch: * To Do * In Progress * Done Nesplnené úlohy, ktoré sa nestihli
dokončit’ v danom šprinte, presunieme do nasledujúceho šprintu.

Vytváranie exportov z TFS

Navod na stranke: https://msdn.microsoft.com/en-us/library/dd286627(v=vs.110).aspx

URL: https://tfs.fiit.stuba.sk:8443/tfs/

Login: ako do AIS-u

Pred prvým exportom je potrebné si vytvorit’ query, ktoré vráti stav úloh v danom šprinte. Návod na vytvorenie quory:

100 Chapter 2. Pre vývojárov

https://msdn.microsoft.com/en-us/library/dd286627(v=vs.110).aspx
https://tfs.fiit.stuba.sk:8443/tfs/


3dSoftViz Documentation, Release v0.1

Excel

• V hlavnom menu vybrat’ záložku TEAM (mala by byt’ vpravo hore).

• Klik na New List ( umiestnená na l’avo pod záložkou File/Súbor).

• Vybrat’ novo vytvorené query:

• Hotovo

2.4.10 Logovanie s knižnicou Easylogging++
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Úrovne logovania

Easylogging++ poskytuje tieto úrovne logovania:

• Global Generická úroveň, reprezentujúca všetky ostatné

• Trace Zachytávame informácie, vhodné na back-trackovanie rôznych problémov.

• Debug Zaznamenávame informácie, vhodné pri vývoji aplikácie.

• Fatal Používame ked’ nastane chyba, ktorá pravdepodobne ukončí program.

• Error Používame ked’ nastane závažnejšia chyba ale program bude nad’alej pracovat’.

• Warning Používame ked’ nastane chyba ale program bude nad’alej pracovat’.

• Info Používame na zachytenie priebehu aplikácie.

• Verbose Nepoužívame.

• Unknown Nepoužívame.

Čo a ako treba logovat’

Čo je potrebné logovat’:

• Začiatok každej metódy

• Všetky možné errory / warningy

Ako treba logovat’:

• Začiatok každej metódy logujeme v tvare

function(){
LOG( INFO ) << "MENO_BALIKU/MENO_TRIEDY/MENO_FUNKCIE(PARAMETRE)"

}

Pozor, parametre používat’ iba v prípade, že je to vhodné

• Všetky možné errory / warningy logujeme v tvare

LOG( WARNING/ERROR/FATAL ) << "MENO_BALIKU/MENO_TRIEDY/MENO_
→˓FUNKCIE(PARAMETRE)"

V tomto prípade sa snažíme zalogovat’ aj všetky potrebné parametre, ktoré spôsobili warning / error

2.4.11 Metodika na písanie BDD testov

Písanie testov

1. Vytvorme normálny .cpp súbor a v hlavičke uved’me:

#include <igloo/igloo_alt.h>
using namespace igloo;

2. Najskôr popíšeme, čo chceme testovat’ pomocou Describe-u:

Describe(a_foo_bar) {
...
}
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3. V tele Describe-u uvedieme funkcie, ktorými budeme testovat’ spravanie. Funkcie pomenujme tak, aby boli
samoopisné:

It( foo_should_be_bar ) {
...
}

4. V tele It-u už píšeme klasické asserty, eg:

Assert::That( 2+4, Is().EqualTo(6) );
Assert::That( "FIIT", Is().EqualTo("LIFE") );

Spustenie testov

1. Testy (vsetky *.cpp) pre vas modul umiestnujte do priecinka:

~root/tests/Foo

Testy fungujú tak, že si buildnete vlastný .exe súbor, ktorý odtestuje danú funkcionalitu. Test si buildnete následovne:

• otvorte hlavný CMakeLists.txt

• ctrl+f -> “BDD Igloo tests”

2. Teraz si potrebujete nakopirovat nejaky kod, minimalne by ste mali mat:

file( GLOB_RECURSE SRC_FOO_TESTS "tests/Foo/*.cpp" )
add_executable( test_foo_module ${TEST_RUNNER} ${SRC_FOO_TESTS} )
add_dependencies( test_foo_module igloo )
target_compile_options( test_foo_module PUBLIC ${FLAGS_FOR_DEBUG} )

Dole pod testami (alebo ctrl+f -> “run all tests”) pridajte ešte jeden riadok kódu:

add_test( testing_foo_module test_foo_module )

3. Teraz musite zmeny ulozit a nechat zbehnut CMake

• pravym na project -> Run CMake

• v QTCreatori zmente build/run target na Tests/test_foo_module

4. Pokial uz mate v priecinku tests/foo testy mali by sa buildnut/zbehnut
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